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Spectrum library searching is a powerful alternative to database searching for data dependent
acquisition (DDA) experiments. Scribe is a new library search engine designed to leverage deep
learning fragmentation prediction software such as Prosit. Scribe embeds Percolator for false
discovery rate (FDR) correction and an interference-tolerant label-free quantification integrator to
enable an end-to-end proteomics workflow.
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OVERVIEW
Scribe comes with a user-friendly GUI interface. The upper left pane contains search options, while the right
pane contains a process queue. The bottom left contains a console that provides specific information about the
process EncyclopeDIA is running.

This manual outlines how to use Scribe, what outputs are given by Scribe, and how to use the outputs to
interpret data.
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1. PREREQUISITES AND INSTALLING SCRIBE
Software requirements needed to process data using Scribe.

Scribe is a cross-platform Java application that has been tested for Windows, Macintosh, and Linux. Scribe
requires 64-bit Java 1.8. While it is possible to use higher versions of Java, many versions are untested. Using
untested versions of Java may result in unknown errors. In particular, Java versions 17 and 18 are known to
cause stability issues in the current release.

A. If you don’t already have Java, install Java 1.8 on your computer. if you are using Windows, you can
download the Windows “x64 Installer” from:
https://www.oracle.com/java/technologies/downloads/#java8. Other operating system options are available at
this URL as well.

B. Scribe is folded into the EncyclopeDIA software package. After you have 64-bit Java 1.8, go to
EncyclopeDIA’s bitbucket page (https://bitbucket.org/searleb/encyclopedia/wiki/Home) and download the most
recent stable version. Once downloaded, double-click on the EncyclopeDIA .JAR file to launch the GUI
interface. If you are using a Macintosh, you may need to right-click on the EncyclopeDIA .JAR and select
“Open” to execute it for the first time with the proper permissions. Click on the tab named Scribe at the top to
search DDA data.

C. We recommend using Proteowizard to create mzML files from your RAW files. You can freely download
Proteowizard from here: https://proteowizard.sourceforge.io/download.html.
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2. GENERATING MZMLS
How to use Proteowizard to generate vendor-neutral .mzML files from vendor-specific RAW files.

A. Before searching files in Scribe, RAW files must be converted to .mzML files using Proteowizard. To do so,
open Proteowizard. Remove the “titleMakers” filter by selecting the filter in the parameters box, and clicking
remove.

B. Add “Peak Picking” by selecting the peak picking option under filters, then click add. This should be the only
filter in the box.
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C. Select your files by clicking “browse”, and locate the desired DDA files in your directory. Click “add” on the
left-hand side of the screen. The output directory will automatically populate where your files were selected
from.

D. Under the options box, the output format should be mzML. You want “write index,” “use zlib compression”,
“TPP compatibility, and “SIM as spectra” selected. Your settings should match the screenshot below.
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E. Click “Start” in the lower right hand corner to start the file conversion.

F. Once complete, the window will look like this. You can exit out of MSConvert once the conversion is done.
Your files will be in the location previously specified.
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3. GENERATING LIBRARIES USING PROSIT AND SCRIBE
How to acquire a FASTA file and then use Prosit and Scribe to generate a spectral library file from it.

The primary library format Scribe uses is .DLIB. Spectrum libraries from Skyline, NIST, TraML and other
formats can be converted to .DLIB using the “Convert” menu. In particular, Scribe can search fully predicted
libraries generated by either Prosit or MS2PIP, and produce input files for both of those tools.  The following
tutorial is given on how to obtain a FASTA file and use Prosit to generate a predicted .DLIB.
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A. To generate a Prosit-predicted spectral library (.DLIB) for Scribe, start by obtaining a FASTA file for your
organism of interest. Given the computational expense of generating libraries, in most cases we recommend
using only canonical protein sequences. For example, if you require a FASTA of proteins sequences for Homo
Sapiens, go to uniprot.org. Select “Reviewed.”

Specify “Human (20,401).”
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Select “Download.” If you download the compressed version,  you will get a .gz and have to
uncompress the file. If you download the uncompressed version, the file may take longer, but it will be
in a FASTA format for immediate use.

B. Open Scribe to create a Prosit CSV from a FASTA file. Navigate to the “Convert.” Select “Create Prosit CSV
from FASTA.” This will open a dialog window.
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Upload the FASTA you have downloaded. The Prosit CSV will be generated in the same folder where
the FASTA is held. If you use the example from the FASTA file provided in the Scribe manuscript, you
should load “uniprot_human-reference_Reviewed_2022mar02.fasta.”

C. Use Prosit to perform an in silico digestion, and obtain an .MSP/NIST format text file. Navigate to the Prosit
website, Prosit. When you get to the page, there are three tabs available; “CE CALIBRATION,” “SPECTRAL
LIBRARY,” and “RESCORING.”
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Go to the “SPECTRAL LIBRARY” tab.

For the 1st step, CSV is already selected. You can click next to get to the 2nd step. Upload the Prosit
CSV created in Scribe.
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Once the CSV has once loaded, click next.

Select the desired model. For this example, we want to use the “Prosit_2020_intensity_hcd” for the
Intensity prediction model, and the “Prosit_2019_irt” for the iRT prediction model. Click next.
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For Task ID Output format, select “NIST .MSP Text Format of individual spectra (Skyline and
MSPepSerach compatible).

Submit the task. It is helpful to record the task number or bookmark the page shown after you submit
the task to come back to once the job is complete.

Once the task is done, download the .MSP file.
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D. Convert the Prosit output (.MSP/NIST) to a Library (.DLIB) using Scribe. In Scribe, go to “Convert,” then
navigate to “Convert SPTXT/MSP to  Library.”  This window will pop up.

Upload the downloaded .MSP file from Prosit, and the FASTA file used to generate the .MSP.

Click okay. The dialog box will indicate the .MSP  file is being converted to a .DLIB. Once it is complete,
the dialog box will tell you.

The resulting .DLIB should be analogous to
uniprot_human-reference_reviewed_2022mar02.prosit_input.trypsin_nce29_hcd2020.dlib.
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4. SCRIBE SEARCH OPTIONS
Descriptions of the search options available in Scribe.

Here is a screenshot of the Scribe default search options:

A. Scribe has several options for searching files. Before you can start loading data, you need to specify both a
.DLIB or .ELIB library to search as well as a background FASTA. These will be shaded red until they are
properly specified. ​​Libraries can be either in the .ELIB (chromatogram library) or .DLIB (spectrum library)
format.

B. Scribe has several other search settings. As a general rule, we recommend using the default search
parameters first. Other settings are defined below:

Target/Decoy Approach: In some circumstances, it may be necessary to add additional decoys
to improve statistical analysis. However, as a general rule, this should be left at “Normal
Target/Decoy”.
Enzyme: Several common digestion enzymes are supported.
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Fragmentation: In general, we recommend using CID/HCD (B/Y) fragmentation for most CID or
HCD experiments. However, if your library is particularly large or messy you may get improved
results with “HCD (y- only)”.
Precursor/Fragment/Library Mass Tolerance: Tolerances can be specified in PPM, AMU, or
resolution.
Percolator Version: Percolator 3.1 is recommended for most experiments.
Number of Cores: This is the number of CPU cores you allow EncyclopeDIA to use. The
maximum value you should set this to is one less than the number of cores your computer has.
You need to leave at least one core for background processes.

C. Additional command line options can be specified in the command line options box. For example:

D. Use the “Add MZML” button to add RAW files for library searching. These will be automatically placed on
the queue and executed in order using the current settings. If an MZML has been previously analyzed, Scribe
will remember where it left off and try to not process it a second time.

Here is a screenshot of the Scribe search queue:

E. Search results can also be saved for downstream quantitative assessment using the “Save Quant Reports”
button. RAW files between these experiments are expected to contain shared peptides so retention-time
alignment is performed and match-between-runs quantification is calculated.
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5. INTERPRETATION OF SCRIBE OUTPUTS
Descriptions of the output files given from Scribe.

Scribe outputs figures as PDFs displaying fits for retention time (RT), MS1, MS2, delta MS1, and delta MS2.
These files can be used to partially assess Scribe’s performance in matching spectra to peptides. Additional
metrics can be found using the Features viewer, described in part 6 of this manual.

A. PDFs and corresponding text files

RT plots show the Prosit-predicted RT to the actual RT detected. The green line shows the trace of the
kernel density estimation (KDE) RT fit. The blue dots indicate peptides that are matched within 3
standard deviations of the green fit. The red dots represent peptides that are rejected by the alignment,
which are outside of 3 standard deviations of the median fit.

In the first fit, peptide FDRs are calculated using Percolator, then fed back into the RT algorithm for
further refinement. The refined, or final retention time fit is represented in the second plot. Peptides that
are sent through the second pass of the Percolator are a low fraction of the peptides that were fed into
the first pass. As a result, the first and final traces only look subtly different. For the remaining plots,
only the final fit will be shown.
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Final Delta MS1 Fit

Similarly to the RT fit, the delta MS1 fit displays the mass error of peptide detections. The error is
calculated by comparing the expected mass of a given precursor to the detected mass. The blue
portion of the peak represents peptides found within 3 standard deviations of this mass error fit, while
the red represents peptides outside of this range.

Final MS2 fit

Precursor m/z and fragment m/z have outputs that plot RT vs precursor mass error. We expect the
acceptable error to be within the mass error that is selected during the peptide search. For this search,
a mass tolerance of 10 PPM was selected for fragment ions, which gives the green line, or the median
mass error fit. The blue dots represent peptides identified within 3 standard deviations of the median
mass error, while the red dots are peptides that fall outside of this range. Although the MS1 and delta
MS2 fit are not shown, both plots can be interpreted using the same principles described here.

D. Other files generated during sample searches and quantitation

Scribe Manual 19



Scribe.txt, decoy.txt, and features.txt
The ending in “.scribe.txt” contains 6 columns. The first column is the PMSid or sample name
concatenated to intensity, peptide sequence, and charge. The next columns contain the scribe score,
q-value, and posterior error probability. The Scribe score is a sum of squares error calculated from the
actual intensity and the predicted intensity. This value reports the difference between the observed
intensity and the predicted intensity. The last two columns contain peptides with protein matches. You
can use this text file to asses the peptide spectral match for targets of interest

Files ending in .scribe.decoy.txt contain analogous scoring and information for the decoys generated for
FDR estimation.

Features.txt files contain the complete 17 scores the Scribe algorithm uses to match peptide spectra to
their target proteins using Prosit-predicted libraries.

Protein and Peptide.txt
After clicking “Save Quant Reports,” a quantitative output is formatted in easy-to-use .txt files at both
the protein and peptide levels. The protein and peptide reports use match-between-runs for
quantification and therefore are only generated if you are searching more than one .mzML file. Quant
report files are formatted as expression matrices that can be analyzed by hand in a program such as
excel, or reformatted for use in a package using software like R or Python. Samples are in columns,
while peptides or proteins are in rows. The number of peptides and the number of fragments are
included as an additional column.

Diffacto inputs
Scribe also produces easy-to-outputs to use in Python with the differential expression tool Diffacto. This
software, developed by Lukas Käll’s research group, is capable of processing and normalizing data
before performing a differential expression analysis using bayesian modeling to select only peptides
that behave similarly to each other. Scribe writes the necessary .csv file for sample abundances, and
the .lst file containing annotations. The .lst output contains sample annotations. The default lists all
samples as separate sample groups. You will need to manually enter sample groupings before using
Diffacto, if you wish for samples to be grouped by condition. To use Diffacto, consult its Github page.

Diffacto citation: Zhang, Bo et al. Covariation of Peptide Abundances Accurately Reflects Protein
Concentration Differences  Molecular & Cellular Proteomics, Volume 16, Issue 5, 936 - 948.
https://doi.org/10.1074/mcp.O117.067728.

F. Library, .dia, and model files
When Scribe performs quantitation on individual files, or match-between-run quantitation of multiple
files, an ELIB file is generated as a part of the output. ELIB files contain the same information present in
DLIBs, with retention time information added. The ELIB output can be uploaded to Skyline or
EncyclopeDIA to visualize peptides, or opened in a SQLite DB Browser to extract specific information
using a query. Refer to part 6 for more information on how to visualize ELIBs and DLIBs.

Scribe writes .dia files as it is processing samples against predicted libraries. These files are read by
EncyclopeDIA when visualizing .mzML files, and can also be read in Skyline.

MODEL files are necessary for visualizing data in EncyclopeDIA, and should not be deleted or moved.
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6. VISUALIZING DATA WITH BUILT-IN FEATURES
Three ways to access data processed by Scribe,

Using the outputs you obtain from Scribe or EncyclopeDIA, you can visualize the data using three methods;
through an SQLite database browser, using Scribe, or looking through the data manually within excel. This is
not an all-inclusive list of ways to analyze or visualize the data.

A. Accessing the data through SQLite
ELIB and DLIB files are formatted as SQLite databases, allowing users to access the data through an
SQLite viewer, such as DB Browser for SQLite. Below is a map of how DLIB databases are structured.
SQL databases contain tables, which are represented as boxes in the map, the names of these tables
are “entries,” “metadata,” “peptidequants,” “peptidescores,” “peptidetoprotein,” and
“proteinscores.”Each box contains the column names within the tables and the type of data each
column contains. For example, “PeptideCharge” is formatted as “int,” indicating the peptide charges are
integers in the data table.

To open the browser, double-click the icon on the desktop, or find the program in the location it was
downloaded.
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Once the database browser is open, go to the File > Open Database menu option, then find the ELIB in
the location where it is stored.

On the first tab, you can visualize the database structure. For example, the first file in the database is
the “entries” table, as you can see below. This matches the information seen in the map above. You can
see there are 9 tables in total. Below the tables, are indices, which are lookups for finding information
within tables.
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If you click on the next tab, “Browse Data,” you will be able to look through tables.

You can use filters to obtain specific data you are interested in, or use regular expressions for a more
powerful query.  To export a table you are interested in specifically, click “File > Export > Table(s) as
CSV.”
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For more information on using DB Browser for SQLite check out the SQLite Browser Wiki Github Page.

B. Looking at data through Scribe’s built-in visualization tools.
EncyclopeDIA and Scribe have built-in tools to help you visualize raw data, in .mzML format, libraries,
and quant reports. Use the View menu to access the following options for visualizing data.

ELIB Browser
Click on “Launch ELIB Browser” to visualize a library relative to an individual sample. Click “edit” to
select the library file you would like. Then do the same for the RAW  file, in .mzML format. Note:
EncyclopeDIA cannot read files in RAW form.
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Once the files are loaded, peptides will populate. The screen will pull up this view.

At the bottom, use the search bar to search for specific proteins or peptides. You can see in this
example, the precursor spectra for the peptide “VVSSSIVDK” is symmetrical. For the MS2 spectra, the
b2, b4+2H, y3, y6 y7 and y8 peptides were detected without interference. Visualization is presented as
chromatograms, showing the relationship between ions in multiple spectral acquisitions of the same
peptide.
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Multi-ELIB Browser
Click on “Launch Multi-ELIB Browser” to visualize data across all raw files in a quantitative result.
Using this view, you can visualize peptides present in multiple samples.

Click “edit” to upload the results file you are interested in viewing. You can insert the library file as well,
although it is not necessary to visualize samples. Once uploaded, the view should look like this:

The minimum number of fragments per peptide can be set to limit the peptides that need to be
examined. The number of columns can also be changed. The sample order will be in either numerical
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or alphabetical order. Visualization is presented as chromatograms that show the relationship between
ions in multiple spectral acquisitions of the same peptide.

Similar to the ELIB browser, you can search for specific peptides, or click through the list of detections:
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In the lower left panel, there are intensity bar graphs for “Relative Intensities” and “Total Intensities”
across samples. Scribe uses precursors for quantitation, therefore the “Relative Intensities” bar graph
will always consist of the intensity values for a single precursor across all samples. “Total Intensities”
will allow you to compare quantitative intensities across samples. Below are both graphs for the peptide
selected in the screenshot above.

Raw File Browser
“Launch raw File Browser” will allow you to visualize samples, in mzML format. In this view, you can
visualize unsearched data. The data is present in scans, allowing you to visualize the MS1 and MS2
spectra for specific scans throughout your injection
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The next tab contains intensity distributions for precursor and fragment ions present in each scan in the
bottom pane. In the top pain, you can see the base peak chromatogram trace.

Contaminant peaks from common molecules, such as PEG, triton, tween and polysiloxane are present
in the base peak trace. If you look in the screenshot below, you will see PEG +3H 30 base peak present
in the chromatogram around 34.5 minutes.
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Peptide Browser
“Launch Peptide Browser” will allow you to search for a specific peptide in a sample file of interest.
When you first open this browser, the peptide “VATVSLPR”, a common tryptic peptide, is selected. The
top left panel displays the chromatogram trace for this peptide across the entire gradient. The bottom
left panel shows the XCorr score across the gradient. You should see the highest score where the most
intense peak is for the peptide. On the right side of the screen are the scans throughout the gradient.
Visualization is presented as chromatograms that show the relationship between ions in multiple
spectral acquisitions of the same peptide.
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In this next view, the base peak has been zoomed in under the chromatogram panel in the top left. You
can see this peak elutes around 23.8 min. A scan acquired at 23.737 min has been selected to pull up
the MS2 spectra in the bottom-right corner.
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Feature Browser
“Launch feature browser” will allow you to visualize the features.txt files output from Scribe or
EncyclopeDIA. The tabs of the features browser contain various metrics used in matching predicted
spectra to peptides. Below is a screenshot of the ROC plot, which shows the performance of the 13
features available through this browser. On the x-axis is the Q-value, or the chances of a given feature
resulting in a false positive rate (FPR). On the y-axis are counts, indicating the number of peptides
detected at a given FPR. Features that are lower on the curve have worse performance than features
higher on the curve. For example, “ms2MassError,” denoted by the dark blue line, performs the worse
of the given characteristics and is only useful as a correction factor in this case.
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Each of the other tabs contains histograms of the individual scores for target and decoy peptides. For
example, below is the dot product plot where a value closer to 1 indicates greater similarity between the
actual and predicted spectra. In this plot, you should see the decoy trace (in red) reside lower than the
target trace (in blue).

For the remaining features, you should also see the target trace (blue) relative to the decoy trace (red).
This indicates the target spectra are performing better than the decoy spectra, which should occur
when a peptide match is matched correctly.
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C. Analyzing text files using Microsoft Excel
After saving a quant report, Scribe will perform a match-between-runs quantitation of all samples you
obtained and then write a protein and peptide report. These are formatted as expression datasets of the
proteins or peptides detected. This expression dataset allows you to use Open the text file in Excel by
right-clicking on the file, open with excel. The following example shows how to process the protein
reports for HeLa DDA injections at varying NCE processed against a library optimized against NCE =
27. Within this example, the file was “saved as” .XLS file to ensure that the equations are saved. Below
is a screenshot of the file once it has been opened.
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Add column annotations to describe the sample names/conditions for each injection. In this example,
NCE was added as an annotation row.

In excel, sort values in increasing order. For example, in HeLa, a mammalian immortalized cancer cell
line, the most abundant proteins are often metabolic enzymes (G3P) or filament proteins (ACTB).
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Calculate the sum of all intensities in each sample. Divide each intensity by this sum.
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Calculate the average of the summed intensity for all samples (using the values calculated in step 2).
Multiply each value by the average summed intensity. Repeat for all values in the data matrices.
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Log2 transform the data matrix.

To visualize relative intensities across injections, you can copy and paste your matrix into a
downstream tool, such as BoxplotR: http://shiny.chemgrid.org/boxplotr/
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7. WALKTHROUGH WITH DEMO DATA
Tutorial for how to process data using Scribe and a Prosit generated library.

A. You can download data used in the Scribe manuscript from:
https://massive.ucsd.edu/ProteoSAFe/dataset.jsp?task=99b781c9c0b84ac9bfc3f93734e9ddab

To start, we recommend downloading the following files for this walkthrough:
● 2022_09_01_HeLa_500ng_16mzst_DDA_NCE_27.mzML
● Uniprot_human-reference_reviewed_2022mar02.fasta
● uniprot_human-reference_reviewed_2022mar02.prosit_input.trypsin_nce29_hcd2020.dlib

B. Specify [uniprot_human-reference_reviewed_2022mar02.prosit_input.trypsin_nce29_hcd2020.dlib] as the
library and [uniprot_human-reference_reviewed_2022mar02.fasta] as the background FASTA. The DLIB library
was generated using the method explained in part 3 of the manual. We will use a “Normal Target/Decoy”
approach, and select “Trypsin” as the enzyme. The fragmentation is set to CID/HCD (B/Y). Precursor mass
tolerance, fragment mass tolerance, and library mass tolerance are all set at 10 PPM. The latest Percolator
version should be selected, which at this time is v3-01. The settings should match the screenshot below.

C. Then queue up the [2022_09_01_HeLa_500ng_16mzst_DDA_NCE_27.mzML] mzML file by clicking the
“Add MZML” button.”

Processing should begin immediately. Detailed analysis information will be printed in the console
portion of the screen, and a blue bar will move across as the job is processed:

Scribe will complete several steps in order: conversion of the mzML to DIA format, library search
scoring, Percolator filtering, retention time alignment, Refined Percolator filtering, and then
quantification. The resulting search should detect and quantify around 34,398 unique peptides,
matching the manuscript result from Figure 3. The specific number may change by a small amount
depending on your operating system because of sort ordering in Percolator.
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D. Once the file for this library has concluded running, the file bar will turn green. Although there is only one
file, and match-between-runs quantitation will not be performed, we can click “Save Quant Reports.”

Once the quantitation has concluded, the screen will look the same as the screenshot below. At this
point, you should exit from Scribe, and re-open a new window before running another search.

E. To process the other files found in the repository, consult the table below. DLIB Libraries are paired to HeLa
mzMLs based on experimental NCE and Prosit NCE, where NCEs are tuned to the specific instrument. Here
are the pairings for this experiment in Figure 3 and Figure 4:

Experimental NCE Experimental File (mzML) Library File (DLIB)

22 2022_09_01_HeLa_500ng_16mzst_
DDA_NCE_22.mzML

uniprot_human-reference_reviewed_2022mar02.pro
sit_input.trypsin_nce16_hcd2020.dlib

27 2022_09_01_HeLa_500ng_16mzst_
DDA_NCE_27.mzML

uniprot_human-reference_reviewed_2022mar02.pro
sit_input.trypsin_nce29_hcd2020.dlib

32 2022_09_01_HeLa_500ng_16mzst_
DDA_NCE_32.mzML

uniprot_human-reference_reviewed_2022mar02.pro
sit_input.trypsin_nce34_hcd2020.dlib

37 2022_09_01_HeLa_500ng_16mzst_
DDA_NCE_37.mzML

uniprot_human-reference_reviewed_2022mar02.pro
sit_input.trypsin_nce41_hcd2020.dlib

42 2022_09_01_HeLa_500ng_16mzst_
DDA_NCE_42.mzML

uniprot_human-reference_reviewed_2022mar02.pro
sit_input.trypsin_nce50_hcd2020.dlib

If you run into error messages or Scribe shuts down, please check your version of Java. Ideally, you will
be using Java version 1.8. We know of errors that were introduced with Java versions 17 and 18 and
we recommend using Java 16 or earlier to ensure stability.

F. Plot the number of peptides identified in each run in any downstream software (e.g., R or Excel). The
resulting graph should be similar to the figure below.
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8. USING SCRIBE TO BUILD LIBRARIES FOR DIA SEARCHES
How to use spectral libraries made from DDA to search against DIA experiments

A spectral library, .DLIB, file is output from Scribe. With the latest version of EncyclopeDIA, you can use
the acquired spectral library to search DIA injections. In this example, we are using the collision energy
optimized library acquired from a HeLa DDA injection with NCE = 27. Open EncyclopeDIA, and upload
“2022_09_01_HeLa_500ng_16mzst_DDA_NCE_27.DLIB.” Specify
“uniprot_human-reference_reviewed_2022mar02.fasta” as the background file. The settings should
match the screenshot below.
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Click “Add mzML,” then find the DIA injection named
“2022_09_01_HeLa_500ng_16mzst_DIA_01.mzML” to begin the search.

Once the search is complete, the detected number of peptides should be “31,349.”
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You can then visualize detected peptides as chromatograms using the “ELIB Browser.” The peptide below is an
example of a peptide that was detected with little interference and multiple fragment ions.
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9. FAQ
A. Can multiple organisms be searched at once?

Yes, you can by generating a Prosit library for each organism using the method outlined in part 2, then
using Encyclopedia/Scribe’s “Combine Multiple Libraries” feature to merge both DLIBs. With this
method, both organisms can be searched at once.  The specified FASTA file contains both organisms.
The “Combine Multiple Libraries” feature is outlined below:

Click on “Add Files or Drag Into Box” to add files to the queue. Then select “Library” at the bottom of the
window to name the merged library. Click okay to start the process.

Scribe Manual 46



B. When are additional decoys necessary?
Scribe can search for additional decoys as entrapment peptides by adjusting the “Target/Decoy
Approach”. When doing this, Scribe adds additional entrapment peptides that are generated by
shuffling the sequence of target peptides. Decoy entrapment peptides (reverse shuffled) are also
added. If the percentage of detected entrapment peptides is higher than the filtered FDR percentage,
then this can help indicate potential errors that escape target/decoy analysis performed by Percolator.

For more information on entrapment as a tool for estimating confidence in proteomics datasets, we
recommend the following paper:
Granholm, V., Fernández Navarro, J., Noble, W.S., Käll, L.: Determining the calibration of confidence
estimation procedures for unique peptides in shotgun proteomics. J. Proteom. 80, 123–131 (2013)
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